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OFFICIAL PyMOL MANUAL

(For PyMOL Sponsors)

A first installment

Although this is not Chapter One, this is the first chapter we are posting for your use 
and feedback, a part of our expanded documentation system for PyMOL sponsors.

This chapter is intended to get new users up and running on PyMOL, without  plodding 
through a formal review of every detail. It is planned as an early chapter of a compre-
hensive manual, so you will find many references to chapters that are not included here. 
Nonetheless, we think you may find it helpful, especially if you are a new user. Please 
email help@schrodinger.com if you find it in any way confusing or incomplete for a 
user’s first encounter with PyMOL.

Only for sponsors

This is an incentive product for PyMOL sponsors. Please do not post it publicly or     
otherwise share it with the general public. Incentive products, such as this manual, are 
exclusively for sponsors, and sponsors are what make possible PyMOL’s continued de-
velopment, documentation, and support.  To confirm or inquire about sponsorship, 
please email sales@pymol.org.
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X. HITTING THE GROUND RUNNING
This chapter introduces the PyMOL interface, PyMOL’s capabilities, 
and the commands and representations you need for creating and 

saving images. The aim is not complete coverage, but simply to help 

you get off and running. The information here corresponds to PyMOL 

version 1.2.r1.
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PyMOL Layout and Features

Figure X.1 The PyMOL user interface on a Windows PC

PyMOL user interfaces on various computers

There are some differences in appearance (and a few differences under the hood) be-
tween the versions of PyMOL that run on WindowsTM Personal Computers (PCs), Unix/
Linux systems, and MacsTM. For the user, most of the differences are cosmetic. In this 
chapter, we usually show the Windows interface (because most PyMOL users have Win-
dows), and illustrate the differences on the Mac where they count. The Unix/Linux ver-
sion of PyMOL looks a lot like the Windows version.

When you launch PyMOL on a PC (see Figure X.1), two windows appear, one right 
above the other (they are really two separate windows). The top PC window has a Tk 
logo at the top left. We’ll call this the Tk window (some menus call it the Tcl Tk GUI 
window). Below it is the PyMOL Viewer window. 
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The Tk window contains, at top left, a bar of PyMOL pull-down menus, a white box for 
displaying the command history and diagnostic messages, and a live area for typing in 
commands at the bottom left. To the right is a bank of button controls. Below the Tk 
window, the Windows PyMOL Viewer window contains the Display Area, the lower 
command line, and several other types of controls in a panel to the right of the Display 
Area.

When you launch MacPyMOL (see Figure X.2), the PyMOL menu appears in the 
AppleTM menu bar at the top of the screen. On the desktop, you’ll find one window con-
taining the Display Area and all the other controls and command lines.

Figure X.2  The MacPyMOL user interface

The main difference between the Mac and the Windows PyMOL interface is the number 
of windows. On the Mac, the topmost menus are incorporated in the Apple menu bar, 
and all the other controls are in one window below. On Windows, the topmost bar of 
menus shares the Tk window with the command history, upper command line, and a 
bar of control buttons.

Controls and information are presented on the right-hand side of the MacPyMOL User 
interface (Figure X.2) and the Windows PyMOL Viewer (Figure X.1). These include a list 
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of names for each object and selection you create, as well as a bank of pop-up menus for 
each object and selection. A block of mouse configuration information, a tab for expand-
ing the Display Area, and a line of VCR-style movie control buttons are also on the right 
side of the Display Area. A secondary command line runs under the Display Area on the 
left. 

Demonstration Wizard
PyMOL contains a set of demonstrations to give you a taste of its capabilities. We sug-
gest you check them out now by opening PyMOL. 

You may want to get into the habit, starting now, of checking that the Caps Lock key on your key-
board is not enabled when you launch PyMOL. When the Caps Lock is enabled, PyMOL's mouse 
controls do not work properly. 

Launch the demonstration wizard by choosing the Wizard pull-down menu from the Tk 
menu bar on Windows, or from the Apple menu bank on the Mac. Then select Demo 
and Representations from the submenus to see the animation of the representation 
types (see Figure X.3).

    

Figure X.3 The demonstration 
wizard shows ten PyMOL capa-
bilities. Choose any one of them 
from the Wizard / Demo menu 
(the Wizard menu is outlined here 
in the top green box), and a list of 
all the demos will appear in the 
objects & selections list to the 
right of the Display Area (also 
shown here boxed in green, on 
the right). 

To view the other demonstrations, left-click on the buttons listing Representations, 
Cartoon Ribbons, etc., to the right of the Display Area.  Some of the demonstrations are 
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interactive and require a three-button mouse to work. This is an important point. To get 
the most out of PyMOL, you need a three button mouse. 

Before you left-click on End Demonstration at the bottom of the list, left-click on Rep-
resentations once more so you can examine the bank of control buttons (shown in Fig-
ure X.4). On the left is a list of the object names, all, rep1, rep2, rep3, rep4, and rep5. 
However, there are eight different objects in the demo. To view the complete list, drag 
down on the scroll slider to the left of the names until you can see the last four, rep6, 
rep7, rep8 and reps. 

Figure X.4  There is a scroll 
slider (here boxed in green) to 
the left of the object names list.

The demonstration wizard is scripted to show some of PyMOL’s capabilities, but many 
functions are not accessible from these scripts. To dig in, the next step is to load a coor-
dinate set. Left-click on End Demonstration to clear the Display Area and the list of ob-
jects & selections.

Loading a Molecule
PyMOL accepts commands in a variety of ways. For example, to load the molecular co-
ordinates from a PDB file, you can use the Open... dialog box under the File menu; or, 
with PyMOL closed, you can drag a PDB file icon from anywhere on your computer 
onto the PyMOL program icon; or, if you are connected to the internet, you can load 
molecules directly from the PDB website, using the PDB identifier for the coordinate set. 
(An updated list of all the file format types PyMOL accepts, and the methods for loading 
are found online.) For example, make sure your computer is online, launch PyMOL, then 
left-click in the upper command line and type

PyMOL> fetch 1acj

(and enter, or return). 1acj is a PDB identifier. PyMOL will download the PDB file to 
your User folder.  If you are not online, but you have access to a PDB file, go ahead and 
open it in PyMOL from the File / Open... menu, which allows you to navigate to the file 
as you would in any other program, depending on your operating system.
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The first thing you’ll notice is that your command is echoed in the command history 
area above the upper command line. Then, once PyMOL has located the PDB file (and 
downloaded it to your User folder when you use the fetch command), it will display a 
representation of the molecule in the Display Area, and echo the header information 
from the PDB file in the command history area (see Figure X.5). The default representa-
tion is lines, colored by element (oxygens red, nitrogens blue, carbons green, etc.). 

Figure X.5 Here, PyMOL has 
loaded and displayed 1acj in 
a lines representation.

Visualization Presets
When PyMOL has loaded 1acj, the lines representation appears in the Display Area, and 
the object name 1acj appears in the objects & selections list. To the right of the object 
name, a row of   buttons appears. The buttons in this row apply only to the 
object 1acj. You can load or create any number of coordinate sets in a PyMOL session. A 
new object and row of buttons will appear for every coordinate set you load, or selection 
you create (Making selections is treated in this chapter, under Making and Representing 
Selections). The object name all appears at the top of the list. The row of buttons next to 
the object name all applies to every object you have loaded. 

Left-clicking on A displays a pop-up cascading menu of Actions that PyMOL can per-
form on the object named in that row. Left-clicking on S displays a list of representations 
and atom types that PyMOL can Show; H displays a similar list of representations and 
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atom types to Hide; L displays Labels that you can add or clear; and left-clicking on C 
gives you a cascading pop-up menu of Colors (A S H L C buttons are treated in this 
chapter, mostly under Representations). We are aiming for a submenu under A Action / 
Preset (see Figure X.6 ).

Figure X.6  Left-clicking on the A Action button, and then left-clicking on preset brings up a cascading 
menu of preset representations from which to choose. In this case, there is only one set of coordinates 
loaded into PyMOL, so left-click on the A Action button in either the 1acj row or the all row. Here, none 
of the presets has been chosen yet.

PyMOL provides you with a set of built-in preset representations for visualizing pro-
teins, nucleic acids, and ligand complexes. For example, the ligands preset enables you 
to visualize the polar contacts made between proteins and ligands. When you apply the 
ligands preset, the 1acj_pol_conts object name appears in the list of objects & selec-
tions to the right of the Display Area. You can toggle the display of polar contacts by left-
clicking on the name 1acj_pol_conts. With polar contacts enabled (gray background 
behind the object name), you can also display the number of Ångstroms between the 
contacting atoms by left-clicking on the S Show pop-up menu next to 1acj_pol_conts 
and choosing labels. Left-click on the H Hide pop-up menu and choose labels to hide 
the distance measurements. 
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Other presets worth trying at this point include technical, ligand sites / transparent 
surface, and publication. Table X.1 shows examples of the visualization presets that 
include solvent (some presets hide solvent molecules).
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Table X.1  Visualization Presets

simple (with or without solvent) A C-alpha 
trace of the main chain is shown with a ribbon 
representation. 

ball and stick Bonds are shown with stick 
representation (stick_radius set* to 0.1). Atoms 
(and solvent) are shown as spheres 
(sphere_radius set to 0.25).

b factor putty This preset runs a script to 
calculate the diameter of the cartoon putty in 
proportion to the crystallographic B-factor. Sol-
vent is not shown.

technical The backbone is shown in a ribbon 
representation. Side chains are lines, ligands are 
sticks, and polar contacts are dashed lines. 
Solvent is shown with crosses.

ligands PyMOL zooms in on a ligand, shown 
as sticks, with polar contacts as dashed lines. 
The protein backbone is shown as a ribbon, 
side chains as lines, and solvent as crosses.

ligand sites (mesh surface) PyMOL’s 
camera zooms in on a ligand site, representing it 
as a mesh surface, with stick representa-
tion for the site side chains and ligand.

pretty (with or without solvent) The protein 
is in cartoon representation and the ligand is 
in sticks. Cartoon settings include round 
helices and fancy flat sheets.

publication (with or without solvent) The 
protein is in cartoon and ligand in sticks. 
The cartoon settings include fancy helices, 
and sheets, and highlight color.

*PyMOL’s settings are an advanced topic, treated in Chapter XX, and on the web.*PyMOL’s settings are an advanced topic, treated in Chapter XX, and on the web.
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Navigation

Fig. X.7  If you click in the PyMOL Display Area without dragging, 
you may cause pink boxes or white globes to appear. For now, just 
left-click in a blank area to be rid of them. (See Selecting with the 
Mouse and Chapter XYZ for the functions of the globes and boxes.)

Fig. X.7  If you click in the PyMOL Display Area without dragging, 
you may cause pink boxes or white globes to appear. For now, just 
left-click in a blank area to be rid of them. (See Selecting with the 
Mouse and Chapter XYZ for the functions of the globes and boxes.)

Dragging the mouse — middle button pressed — for translations

Figures X.7 through X.11 guide you through the basic mouse-dragging operations. The 
black arrows represent your cursor in the Display Area, and the green arrows represent 
paths for moving the cursor. Figures on the left are “before” you drag. Figures on the 
right are “after.” To match the figures, connect to the internet, launch PyMOL, and type 
in the upper command line

PyMOL> fetch 3cln

(and enter, or return). PyMOL will download coordinates for calmodulin from the PDB. 
Choose Display / Background  / Light Grey from the top bank of menus. Find the ob-
ject name 3cln, pull down the A Action menu, preset, then publication.

Fig. X.8  First place the mouse so the cursor shows on or near the molecule in the 
Display Area. Push down on the middle mouse button and drag. The molecular 
representation will translate in the plane of the screen (picture plane).
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Dragging the mouse — left button pressed — for rotations

Figure X.9  Dragging the mouse 
straight across, starting with the 
cursor at mid-screen height, pro-
duces rotation out of the picture 
plane. The rotation axis is ori-
ented vertically in the picture 
plane.

Dragging the mouse along an 
edge of the screen produces rota-
tion in the picture plane. This 
works at top, bottom, left and 
right edges. The rotation axis is 
perpendicular to the picture 
plane.

Dragging the mouse straight 
vertically with the cursor at cen-
ter screen-width produces rota-
tion out of the picture plane. The 
rotation axis is oriented horizon-
tally in the picture plane. 

Dragging the mouse diagonally, 
starting with the cursor at any 
position, produces a rotation 
about an axis that pierces the 
picture plane at an angle.

The PyMOL Trackball (See Figure X.10.) When you press and drag using the left mouse 
button, the rotation behavior depends on where the cursor is when you start, and the 
direction in which you drag. For simple rotation about an axis located in the picture 
plane, always move the cursor along a horizontal or vertical line that passes through the 
center of the Display Area. In contrast, for rotation about an axis perpendicular to the 
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screen, drag along one of the edges of the Display Area. Moving the mouse in an inter-
mediate path between these two extremes will generate mixed behavior, and enable you 
to rotate the molecule about any axis you wish.

Figure X.10 Dragging the mouse 
with the cursor in the Display Area 
with the left mouse button de-
pressed rotates the display like a 
virtual trackball. 

To understand what is going on when you drag the mouse with the left button de-
pressed, imagine what would happen if you pressed your index finger against a heavy 
bowling ball, and then moved your finger in some arbitrary direction while continuing 
to press. If you moved your finger near the top of the ball in the center, then the ball 
would simply roll in the same direction as your finger. However, if you pressed the side 
of the ball, then the ball would tend to rotate about the axis pointing at you from the cen-
ter of the ball. If your pushed from someplace between the center and the edge of the 
ball, the response would be a combination of rolling and rotation. That is essentially how 
PyMOL's virtual trackball works. The positions of PyMOL rotation axes are treated more 
specifically in Chapter XX.

If you prefer, you can disable the virtual trackball by deselecting Virtual Trackball in the 
Mouse menu (at the top of your screen on a Mac, and at the top of the Tk window on a 
Windows PC or Unix system). Rotation will then be restricted to axes in the picture 
plane.
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Reset and zoom

Investigations with PyMOL can take you far afield from the default view of your mole-
cule that PyMOL presents when you first load the coordinates. You can always get back 
to the original view. Left-click the Reset button (just to the right of the white command 
history and diagnostics area) to restore the original view of your molecule. If you have 
simply moved the virtual camera too deeply inside a structure, and need a longer view, 
the Zoom button will pull the camera out toward you so you can see the entire molecule 
in the Display Area. Then the right mouse button can be used to gradually zoom back 
into the structure with a renewed perspective on your position. In the Saving and restor-
ing sessions section, we’ll show how to save and restore program states. In Chapter 
XYZ, we’ll show how to save views of a molecule in a log file, or script.

Dragging the mouse — right button pressed — for zooms

Figure X.11 With the right 
mouse button pressed, drag-
ging the mouse toward you, 
moving the cursor down the 
Display Area, will enlarge 
the image.

With the right mouse button 
pressed, dragging (pushing) 
the mouse away you, mov-
ing the cursor up the Display 
Area, reduces the image.
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Clipping with the scroll wheel

Clipping gives you the ability to focus on interesting parts of your molecule while elimi-
nating interference from other parts. A black background with a lines representation is a 
good combination for manipulating clipping planes (see Figure X.12). Reset the viewer 
window to the original view by left-clicking the reset button; choose A Action / preset / 
default, and choose Display / Background / Black from the top bank of menus. Place 
the cursor in the Display Area, and try rolling the mouse scroll wheel backward, toward 
you. Various portions of the molecule should disappear from both the front and the back 
of the molecule. Now roll the scroll wheel in the reverse direction, forward, away from 
you. Portions of the molecule that previously disappeared should now reappear. This is 
the simplest way to control clipping in PyMOL.  

Now press the keyboard Shift key and continue to hold it down while scrolling. PyMOL 
will translate the clipping slab relative to the molecule. The molecule will not appear to 
move; just what is visible will change. Next, press the keyboard Control (CTRL) key and 
hold it down while you roll the mouse wheel. The molecule will appear to be moving 
toward you or away from you.

Whenever you use a key on the keyboard in combination with the mouse to control PyMOL, press 
the key first, and continue to hold it down while you use the mouse.

Clipping with the right mouse button 
For finer control, hold down the Shift key and the right mouse button. Then drag the 
mouse vertically to move the front clipping plane, and drag horizontally to move the 
back clipping plane. Try adjusting the thickness of the clipping slab to display approxi-
mately one single layer of amino acids. Try rotating, panning (translating), and zooming 
using the left, middle, and right buttons. With some practice, you should be able to 
navigate to display interesting side chain interactions.
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Figure X.12  In the Default preset 
(Lines representation), it is possible to 
spot interesting interactions and navi-
gate to frame them. The sidechain 
arrangement shown here was found in 
the 3cln.pdb coordinate set.

We’ll return to clipping in the Practice section.

Centering with the mouse — middle button click

An interesting way to navigate through a structure is to step from one center of interest 
to another. To see how this works, left-click on the reset button. Position the cursor over 
an atom of interest, and click and release the middle mouse button or wheel. PyMOL 
will then move the molecule so that the atom you middle-clicked over is at the center of 
the Display Area and the clipping slab. When you then rotate (drag the mouse with the 
left button depressed), the axis of rotation will go thru the central atom so you can see it 
from all sides. Middle-click on another atom and it will play the same central role.

Representations

 Representation menus

Occasionally, a PyMOL preset will provide exactly the representation you need. How-
ever, you may want to control representations more closely. Representations are con-
trolled using the S Show, H Hide, L Label, and C Color pop-up menus. Every object has 
its own set of pop-up menus, as does each selection (list of atoms) that the user defines. 

When you use a S Show or H Hide menu for an object, the representation of all the 
atoms in the object are shown or hidden, and the changes are cumulative. For example, 
if you S Show sticks, S Show spheres, and then S Show dots, every atom in the object 
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will have all three representations active at once in the Display Area. If you then H Hide 
spheres and H Hide dots, only the sticks representation will remain visible. 

The S Show menu has a cascading as submenu (see Figure X.13, left), which enables you 
to hide all other representations while showing only the representation you choose. For 
example, if you S Show / as sticks, and then S Show / as dots, only the dots represen-
tation will remain visible. Take a moment to experiment with the S Show, S Show / as, 
and H Hide pop-up menus and the various representations. Note that the surface and 
mesh representations take some time to compute for larger molecules. 

nb_spheres in the S Show and H Hide menus refers to special small spherical represen-
tations of molecules that are not assigned bonds in the coordinate file, such as waters 
and simple ions. nonbonded refers the same molecular locations, represented as crosses. 
Figure X.13 describes the use of other entries in the S Show and H Hide menus.

The C Color menu has several cascading submenus. There are alternatives for coloring 
atoms by element, and alternatives for distributing colors over chains or secondary 
structures (ss). Each color listed at the bottom of the menu has a submenu of variants.

As shown in Table X.2, the L Label menu is useful for identifying structures in close-up 
views of a molecule.   

Table X.2 Examples of useful labels from the L Label pop-up menu

 atom name b-factorb-factor

element symbol occupancyoccupancy
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residue name vdw radiusvdw radius

residue identifier formal charge partial charge

chain identifier rankrank
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Figure X.13  In addition to the representations in the S Show menu, there are four atom-type key words 
(boxed in green on left); organic, main chain, side chain and disulfides. There are five atom-type key 
words (also boxed in green) in the H Hide menu. Here we use the PDB file 1z6s to demonstrate these op-
tions. The recipe for producing the figure on the right is:

PyMOL> fetch 1z6s

(and enter, or return).
Next to the all object name, choose H Hide / waters.
Next to the 1z6s object name, choose S Show / as ribbon.
Next to the 1z6s object name, choose S Show / disulfides / Show sticks.
Next to the 1z6s object name, choose S Show / organic / Show spheres.

Figure X.13  In addition to the representations in the S Show menu, there are four atom-type key words 
(boxed in green on left); organic, main chain, side chain and disulfides. There are five atom-type key 
words (also boxed in green) in the H Hide menu. Here we use the PDB file 1z6s to demonstrate these op-
tions. The recipe for producing the figure on the right is:

PyMOL> fetch 1z6s

(and enter, or return).
Next to the all object name, choose H Hide / waters.
Next to the 1z6s object name, choose S Show / as ribbon.
Next to the 1z6s object name, choose S Show / disulfides / Show sticks.
Next to the 1z6s object name, choose S Show / organic / Show spheres.

The all object name is at the top of the list of named objects & selections (user-defined 
lists of atoms). Choosing from the all menu enables you to apply actions and representa-
tions to all objects that are currently loaded into PyMOL. For example, if you wish to 
hide all representations of all objects, you can choose everything from the H Hide pop-
up menu next to all. In Figure X.13, the all menu is used to hide waters.

Practice 

Here we demonstrate the use of clipping with a protein-DNA structure, in which we iso-
late protein-DNA interactions.  To follow along, type in the upper command line:

PyMOL> fetch 1zaa

(and enter, or return).  Next to 1zaa, choose S Show / as sticks. Change the color 
scheme of the elements under the C Color menu by choosing the by element scheme 
with yellow carbons. This changes the color scheme for every chain (protein and DNA) 
in the 1zaa object.

Now, to distinguish the DNA chains from the protein, type in the upper command line 
to make the selection:

PyMOL>  select dna, chain a or chain b

(and enter, or return). The PyMOL user interface changes in two ways. Pink boxes ap-
pear in the Display Area, associated with every atom that is in the DNA a chain OR 
DNA b chain. The selection name (dna) appears  in the list of objects and selections.  The 
parentheses signal that this is a selection. Make the pink boxes disappear by left-clicking 
on Deselect in the bank of control buttons to the right of the command history and di-
agnostics window. Left-click on the C Color button to the right of (dna) and choose Cy-
ans / cyan, or any color you prefer.

©  2 0 1 0  S c h r ö d i n g e r,  L L C                 J a n  2 0 1 0  D r a f t                    F o r  P y M O L S p o n s o r s  O n l y    21



Use the keyboard shift key and the right mouse button to adjust the thickness of the 
clipping slab to display approximately a single layer of amino acid and nucleotide resi-
dues. When you hold down the Shift key and the right mouse button, and drag the 
mouse vertically, the front clipping plane moves. Keeping the Shift key and right mouse 
button depressed while you drag horizontally will move the back clipping plane. Figure 
X.14 shows examples of protein-DNA interactions you can isolate in this way.

Figure X.14. On the left, the clip-
ping plane focuses on DNA chain 
a, G7, and zinc finger protein 
residues Arg46 and Asp48 (PDB 
file 1zaa). On the right, His49 and 
DNA chain a, G6, come into 
view, and zinc finger residues 
Arg46 and Asp48 are clipped out.

Making and Representing Selections
When working with molecular structures, you may want to show different atoms using 
various representations and colors. In Figure X.13, we demonstrated this with a few key 
words that are available in the S Show and H Hide menus.  However, you can only dis-
tinguish a few types of atoms from those menus, and doing so does not create a new se-
lection.

PyMOL's selection methods enable you to select any atom or group of atoms within an 
object, or across multiple objects. These methods add the selection to the list of objects & 
selections to the right of the Display Area, enabling you to operate on them in a variety 
of ways, and to come back to them as convenient. The selection is highlighted in the 
Display Area by pink boxes centered over each atom in it. Typing is the most versatile 
way to make selections and give PyMOL commands (This is covered in Chapter XYZ). 
In this chapter, we focus on selections and commands created by clicks of the mouse.

Selections behave simply as lists of atoms, and do not have any properties of their own. 
They are used, instead, as arguments to PyMOL commands.  Once you have named a 
selection of a group of atoms, you can apply any number of PyMOL commands to it, in-
cluding those in the pop-up menus.  
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Selection names appear next to the Display Area, enclosed by a set of parentheses in or-
der to distinguish them from object names. An object is the primary information set that 
PyMOL stores when it reads in a coordinate file. When an object is deleted from PyMOL, 
any selections from that object are useless, because they point to non-existent informa-
tion. On the other hand, you can create and delete selections without changing PyMOL’s 
memory of objects. 

Selecting with the mouse

When you open PyMOL, the Mouse Mode is set to 3-Button Viewing. This setting is 
shown to the right of the Display Area, below the space for the list of named objects & 
selections (see Figure X.15). The setting 3-Button Viewing allows you to make selections 
by left-clicking the mouse over an atom in the Display Area. If the setting is 3-Button Ed-
iting, then you can toggle it to Viewing by left-clicking once on the word Editing. By de-
fault, in 3-Button Viewing mode, PyMOL will select and deselect complete Residues. 
The Selecting setting (also shown in Figure X.15) can be toggled through groupings of 
Residues, Atoms, C-alphas, Molecules, Objects, Segments, and Chains, by left-
clicking on the words that appear to the right of Selecting.  

When you select an atom or group of atoms, pink boxes appear in front of the represen-
tation in the Display Area (Figure X.15). The selection name, which is (sele), unless you 
rename it, appears at the bottom of the selection list with a gray background. As long as 
the selection remains active, that is, as long as the pink boxes remain in the Display Area 
and the background behind (sele) remains gray, you can make alterations to the selec-
tion using the pop-up menus in the (sele) row, or by more advanced methods (see 
Chapter XYZ). You can add to the group of selected atoms by left-clicking once above 
other atoms in the Display Area. 

Deactivate the (sele) list by clicking once away from any atoms in the Display Area, by 
left-clicking once on (sele) in the list of objects & selections, or by left-clicking on Dese-
lect (in the Tk window on a Windows PC, or in the top bank of buttons in the PyMOL 
window on a Mac). Any of these actions will deactivate the selection, toggle the area be-
hind (sele) to black, and remove the boxes above the atoms in the Display area. Take 
some time to practice selecting and deselecting atoms, residues and other groups, and 
changing their representations.
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Figure X.15  PyMOL’s Mouse Mode toggles between 3-Button Editing and 3-Button Viewing. You need 
the Viewing mode to make selections with the mouse. The default behavior when you left-click over any 
atom in the Display Area is that the entire residue is selected. Left-click to the right of the word “Select-
ing” to toggle through a list of types of groups you may select when you left-click over an atom in the 
Display Area.

Notice that, if you don’t deselect between left-clicks over atoms in the Display Area, 
PyMOL adds the newly selected atoms to the group of atoms in the selection, (sele).   

Renaming selections 

You can save PyMOL selections by renaming them. Giving meaningful names to selec-
tions helps you to navigate through a PyMOL session. To name a selection, left-click on 
the A Action menu next to (sele), choose rename selection, and then enter the new 
name using the keyboard, and enter, or return. The new name will replace sele.

If you then left-click in the Display Area away from any atom, or left-click on the selec-
tion name in the objects & selections list (toggling the background from gray to black), or 
left-click on Deselect, the next atom or group of atoms you select will start a new selec-
tion with the default name (sele). If you want to add to the list of atoms in a named se-
lection, activate the selection (left-click on its name to make the background gray), and 
then left-click on the atom, residue, or other group that you want to add. Only one selec-
tion can be active at a time.  An example of a representation created by left-clicking, se-
lecting, and renaming is shown in Figure X.16.
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Figure X.16 This is the heme and surrounding aro-
matics from 1mbn, the first protein crystal structure 
ever solved, Kendrew’s myoglobin. The recipe for 
producing the representation in this figure is: type
PyMOL> fetch 1mbn (and enter, or return).
Choose Display / Background / Gray.
Choose 1mbn / A Action / preset / ligands.
Choose 1mbn / S Show / cartoon.
Choose 1mbn / H Hide / ribbon.
Choose 1mbn / C Color / by ss / helix sheet loop.
Left-click on an atom in the heme (in the Display 
Area) to select it. Rename (sele) as (heme). 
Choose (heme) / C color / by element /  NOS. 
Left-click away from all atoms in the Display Area 
to deselect the heme. To make it easier to see the 
line representations, type
PyMOL> set depth_cue=0
Select aromatic residues around the heme by left-
clicking on them in the Display Area.
Rename (sele) as (aromatics).

Choose (aromatics) / S Show / sticks.
Choose (aromatics) / H Hide / main chain.
Choose (aromatics) / C color / by element /  NOS.
Left-click away from all atoms in the Display Area 
to deselect the aromatics. Set Selecting mode to 
Atoms by left-clicking. Left-click on the iron atom 
at the middle of the heme.
Choose (sele) / C color / yellows / yelloworange. 
Select by left-clicking on the oxygen ligand to 
heme. Rename (sele) as (oxygen), show it as 
sticks and color it reds / red.
Left-click away from all atoms in the Display Area 
to deselect the oxygen.
Choose 1mbn / H Hide / lines.
Navigate with the mouse to match the view above.
Left-click on an atom in the heme to reactivate the 
selection and show the pink boxes. One selection, 
(heme), is now active. The objects all, 1mbn, and 
1mbn_pol_conts are also active.

Expanding and extending selections 

Once you have created a selection, you can use the pop-up menus in the row of the se-
lection name to change its representation. For example, the S Show / as sticks action 
was used on the (heme), (aromatics) and (oxygen) selections in Figure X.16. 
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Existing selections can be modified in a variety of ways to include additional atoms or to 
exclude atoms already in the selection. The aromatics selection in Figure X.16 was cre-
ated in this way, by left-clicking on each representation of aromatic residues in the 
neighborhood of the heme in 1mbn. To perform a variety of other modifications, based 
on distances and other criteria, you can use the modify submenu under the A Action 
menu for a given selection. For example, in Figure X.17, the selection (heme) was re-
named (around heme). Then the selection was expanded by choosing modify / expand 
/ by 6 Å, residues in the A Action menu for (around heme).

Figure X.17  Starting from Figure X.16, 
Choose from the objects & selections list (heme) / A Action / rename selection and type: around heme.
Choose from the objects & selections list (around heme) / A Action / modify / expand / by 6 Å, residues.
Choose (around heme) / S Show / lines.
The heme and all residues within 6 Å are shown as lines. However, the heme sticks representation hides 
the heme line representation.
Choose from the objects & selections list (oxygen) / S Show / as spheres.

When you expand a selection, you choose the radius of the included area from the 
menu.  When you extend a selection, you choose the maximum number of bonds within 
which to include atoms or residues in the selection.

Selecting and changing representations in sequence view

You can use sequence information to make selections by choosing the Sequence On op-
tion in the Display menu, or by left-clicking on the S (toggle switch) in the row of Movie 
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Controls. PyMOL will then display sequences for the active objects in a sequence viewer 
at the top of the Display Area. For proteins and polynucleotides, the default is the one-
letter residue code. For ligands, PyMOL usually displays an abbreviated chemical name. 
Selected residues are highlighted in the sequence viewer (see Figure X.18). 

Figure X.18 A protein chain in 1ysa was selected by dragging the cursor, left mouse button depressed, 
over its sequence in the sequence viewer. The rainbow color of the chain shows up behind the sequence 
to highlight it. The usual pink boxes indicate the positions of the selected atoms in the Display Area (in-
cluding the side chain atoms).  After the selection was made, the cursor was placed over a sequence letter 
in the selection and right-clicked to bring up the cascading menus for choosing the color of the selection.

You can make and modify selections by left-clicking and dragging the cursor over the 
sequence letters. When a selection is activated, right-clicking with the cursor directly on 
a residue character in the selection will bring up a menu of actions to be applied to that 
selection. This menu provides an alternative to the object & selections list for altering 
representations of selections (See Figure X.18 and Figure X.19).
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Figure X.19 After the color blue / slate was applied to chain D in Figure X.18, the chain was dese-
lected. Chain C was selected, colored green / forest, and deselected. Leucines (Ls) were selected by 
left-clicking on all the Ls in the sequence viewer, as you see here. The leucine side chains were shown 
as spheres. The recipe for showing only the side chain atom as spheres, and not the main chain atoms, 
is to S show / spheres and H hide / main chain of the selection. Choosing Show as / cartoon again 
for 1ysa then restores the dropped pieces of the main chain. These operations can be done in the pop-
up menus next to (sele) in the object & selections list, or by right-clicking on one of the Ls in the se-
quence viewer to get a pop-up menu.

Figure X.20  Starting from Figure X.19, right-clicking on a selected L popped-up cascading menus. C 
Color / cyans / deep teal was chosen for the L side chains. Left-clicking on the selected Ls in chain D 
deselected them. Then C Color / orange / olive was selected for the L side chains in chain C. Right-
clicking again with the cursor over one of the selected L’s popped-up cascading menus. Note that one of 
the available options is to rename the selection to save it for later use.

©  2 0 1 0  S c h r ö d i n g e r,  L L C                 J a n  2 0 1 0  D r a f t                    F o r  P y M O L S p o n s o r s  O n l y    28



To repeat, left-clicking and dragging the cursor over the sequence display makes the se-
lection. Right-clicking with the cursor over a letter in the selection pops up a menu for 
representing it. If you right-click on an unselected residue in the sequence viewer, then a 
different menu will appear. This menu is titled with identifying information for the resi-
due you right-clicked on, and enables you to perform various actions, such as changing 
colors or altering representations for the residue — without creating a selection. 

Besides selecting and changing representations by clicking the mouse with the cursor 
over letters in the sequence display, you can change your view of the molecule. Middle-
clicking with the cursor over any letter in the sequence will center that residue in the 
display.  Pressing Control (CTRL) on your keyboard and middle-clicking will center the 
display on the residue and zoom in on it.

Changing representations by clicking in the Display Area 

Figure X.21  Right-clicking over an unselected atom in the Display Area brings up a menu of choices for 
representing the groups of atoms to which the right-clicked atom belongs — without creating a selection. 
(The grouping is chosen by toggling through the list of groupings next to Selecting, near the bottom of 
the mouse control matrix to the right of the Display Area). 

As you have seen, left-clicking with the cursor positioned over an atom in the Display 
Area selects the atom and the group to which it belongs, according to the mouse options 
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you have chosen. Right-clicking over a selected atom in the Display Area gives you the 
same cascading menus as in Figures X.18 and X.20. However, when you right-click with 
the cursor over an unselected atom in the Display Area (See Figure X.21), or over an un-
selected residue letter in the sequence display, a different cascading menu pops-up, 
headed by an identification of the atom (or residue, etc.) that was right-clicked. This 
menu gives you the options of applying actions to the atom (or residue, etc.) without 
creating a selection.

Save as You Go 
The many ways to save

During a PyMOL session you may create program states (called sessions), scenes, shows, 
images, molecules, logs, views, and images that you need to save. Here we introduce the 
ways to save sessions, scenes, shows, and images. Chapters XY and Z discuss logs, 
views, and molecules. 

Saving and restoring sessions

You can save a PyMOL session file at any point during a PyMOL work session. The ses-
sion file will contain all the structures that are loaded in PyMOL at that point, and all the 
information for displaying the structures, including colors, representations, and camera 
views. When you reopen a session file, you can continue your work from the point you 
left off. Be sure to save a session file when you are done with a PyMOL session, just as you 
would save a document in a word processor to avoid losing your work. To save a PyMOL ses-
sion in a new session file, choose Save Session As... from the File menu, choose a suit-
able location and type the name for the file, and then left-click Save. To update an exist-
ing session file, choose Save Session. PyMOL session files are given a ".pse" filename 
extension so that PyMOL can recognize them to open them again. On Windows PCs and 
Macs, you can open session files by double-clicking on the session file icon. Or if PyMOL 
is already open, you can choose Open... from the File menu. 

Using session files in place of undo  Presently, there is no “undo” function in PyMOL. 
To keep the amount of backtracking tolerable, it is important to save your PyMOL ses-
sion before you deviate from a satisfactory session state. Act defensively against mis-
takes by saving session files often. Then you can return to a previous state without hav-
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ing to start over from scratch. It’s a good habit to save session files every five minutes when 
using PyMOL for extended tasks.

Creating, viewing and manipulating scenes 

Creating Scenes  PyMOL can store a series of molecular views in Scenes, each with its 
own colors, representations, camera positions, and annotations. Scenes are organized in 
sequence, like the slides in a PowerPointTM presentation. Even when you aren’t prepar-
ing a presentation, storing your work as a series of Scenes is useful for your own docu-
mentation and reference. 

First, choose Buttons, under the Scene menu. This activates a display of Scene names at 
the lower left of the Display Area in the order they will be presented. When you have a 
representation in the Display Area that you want to save, create a Scene by choosing 
Append from the Scene menu (Choose Append for the first representation even though 
you are not literally appending to anything). PyMOL stores the representation in the 
Display Area as a Scene, and automatically assigns a name to it (e. g. "001"). The as-
signed name will appear in the diagnostics display area above the upper command line 
and in the stack at the lower left of the Display Area.

Manipulating scenes  You can then change the view and choose new representations to 
Append as additional scenes in your presentation. Once you have appended two or 
more scenes, use the Next and Previous options in the Scene menu to display the 
scenes. 

More conveniently, you can use the Page Down (PGDN) and Page Up (PGUP) keys on 
your keyboard to move through your scenes. You can also insert new scenes using these 
keys. Press CTRL and PGDN simultaneously on your keyboard to insert the existing 
display as a new Scene after the current one. Pressing CTRL and PGUP simultaneously 
will insert the existing display as a new scene before the current one.

It is also easy to navigate through existing scenes by clicking on the Scene names in the 
stack at the lower left of the Display Area. Clicking on a Scene name activates the scene 
in the Display Area.

The last scene displayed can be updated by choosing Update in the Scene menu. You 
can also add a note to the current scene by typing in the command line, as in

PyMOL> scene auto, update, Some annotation information
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(and return, or enter) will display "Some annotation information" on the screen the next 
time the current Scene is recalled. 

When you save a PyMOL Session, all the Scenes you have defined will be saved as well. 
Other PyMOL users can open the Session file and view the sequence of Scenes you have 
defined.

Saving shows 
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Figure X.22  PyMOL Session and Show files contain the same information, with one exception. They 
contain different instructions to the operating system on how they are to be displayed. Here, we show 
two Scenes being appended in PyMOL’s memory. The same information is saved as a PyMOL Show file 
(with .psw file name extension) and a PyMOL Session file (with .pse file name extension). The Show file 
opens with a full-screen image.  The Session file opens with the PyMOL user interface. Show and Ses-
sion files are interconverted by changing their file name extensions.

A Show file is simply a PyMOL Session file that contains one or more scenes, and is 
saved with a ".psw" file name extension instead of ".pse.” When a ".psw" file is opened, 
PyMOL automatically enters full-screen mode, and begins with the first scene in the se-
quence (See Figure X.22). To see how a PyMOL Show works, double-click the 
"demo_show.psw" file in the PyMOL Tutorial Folder, and use the PGDN and PGUP keys 
to step through the presentation. When playing back scenes, PyMOL animates the cam-
era view to pan and zoom between the scenes. This gives a 3-dimensional sense of flying 
around the molecule. You can manipulate the view using the mouse without corrupting 
the presentation. Press the Escape (ESC) key to return to the desktop.

Interconverting shows and sessions  To convert a PyMOL file from a Session to a Show, 
change the ".pse" file name extension to ".psw". To convert a PyMOL show back to a ses-
sion, change the ".psw" back to ".pse." If you are using Microsoft WindowsTM and cannot 
see the file extension, open the "Folder Options..." from the "Tools" menu of the Win-
dows folder containing your file. Under the "View" tab, make sure that the "Hide exten-
sions for known file types" option is not checked.

Saving images

You can save images from the PyMOL Display Area for presentations or publications by 
creating Portable Network Graphics (PNG) files. PNG files can be read by PowerPoint, 
Microsoft WordTM, KeynoteTM, PagesTM, and many other common programs. Once you 
have the image you want in the Display Area, choose Save Image... from the File menu, 
and enter a suitable destination and name for the file. You can import the saved image 
into PowerPoint by using the PowerPoint "Insert" menu, selecting "Picture" and "From 
File..." More conveniently, you can directly copy and paste images from PyMOL on a 
Windows PC or Mac. On a Windows PC, choose Copy Image to Clipboard in the Edit 
menu. On a Mac, choose Edit / Copy or type Command−C. The Paste command de-
pends on your destination program and operating system. Most programs have Paste 
functions in their Edit menus.
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Ray-tracing images  PyMOL has a built-in renderer for ray-tracing. Ray-tracing and 
rendering eliminate rough edges and generate better lighting effects, including shadows. 
The result is a photorealistic image (see Figure X.23). Once an image is ray-traced, it is 
displayed in the PyMOL Display Area. Then you can save the image with all its photo-
realistic effects in a PNG file. Rendering can be rather time consuming, depending upon 
the complexity of the image, sometimes requiring several minutes. Rendering progress 
is indicated in a bar below the top bank of control buttons. On a Windows PC, you can 
abort a ray-trace process by left-clicking on the abort button in the right bank of buttons 
of the Tk window.

To render a representation in the Display Area, left-click on the Ray button in the top 
bank of control buttons. Then, to save the photorealistic image, before clicking in the im-
age area again, choose Scene / Append or File / Save image as / PNG.  A progress in-
dicator should appear if the Save takes a long time.

Figure X.23 The rough, low-resolution image at top 
left was created with the choice of Quality / Maxi-
mum Performance from the Display pull-down 
menu. (Performance translates into computing 
speed, so this is a good choice when working with 
many atoms.) The image at top right was created 
by choosing Quality / Maximum Quality from the 
same menu. The photo-realism of the bottom figure 
was achieved by ray-tracing.
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Controlling Image Resolution 

By default, PyMOL saves images at the current size and resolution of the Display Area. 
There are two ways to save images at higher resolutions. You can expand the size of the 
Display Area by dragging on the lower right corner of the window. Or, for greater con-
trol, set the number of pixels in the width and height of the image by typing draw or ray 
commands with the width and height as arguments:

PyMOL> draw 1200, 900 

PyMOL> ray 1200, 900 

These commands each generate a 4 inch ✕ 3 inch image at 300 dots per inch (1200 pixels 
✕ 900 pixels).   If you like the shape (aspect ratio) of the Display Area, but need to 
change its size, you can specify only the width, and the aspect ratio will be maintained.
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